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Object In the  Outside the  
 Solar System Solar System

________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________
________________________ _________ ________

Directions: 

List objects you see in the night sky and put a 
check mark in the appropriate column to indicate 
whether each object is in the solar system or 
ouside the solar system. 

Introduction: What’s Out There?
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1. Launch the Image Processor

Launch the program Hands-On Universe Image Processing (HOU-IP). 

The Image Processing icon looks like this:  
Don’t be fooled into thinking the program has not started.  You can 
tell if the program successfully launched if the top of your screen 
looks something like this:

 

 

These pictures show the Image Processing “Tool Bar” and Menus

I. The Moon: Our Closest Neighbor

I-A. The Image Processor

On a Macintosh OS9 computer, double-click the 
“Image Processing” Icon to start up. 

When the Image Processing program is running, 
the icon appears in the extreme upper right corner 
of your screen (see Tool Bar picture below)

If the icon changes to some other icon, you have 
somehow left the Image Processing program. 
You can easily get back to the Image Processing 
program if you simply “click-and-drag” on the 
icon in the extreme upper right corner to select 
“Image Processing” You can always re-launch the 

program, if necessary.

HOU-IP icon for 
Windows & Mac OS9 SalsaJ icon

HOU-IP Windows & Mac OS9 toolbar

SalsaJ toolbar

In SalsaJ, as of 2006, 
there is an oddity of 
operation: in order to 
make any of the menu 
items functional, you 
need to first click on 
the yellow toolbar.

For SalsaJ users
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 Another way to open a file is to use the “Open” command in the “File” menu.

b. You should see a window like the one below.  

clicking on the “Open” file icon    
in the upper left corner of your screen:

2. Open an Image

a. Open the Moon image by 

c. Find the image named 
“craters000314.fts” and open it.  

You should see the image shown at 
right. The circular features are craters—
places where objects have violently 
slammed into the Moon. 

Question 1.  Looking at the image, what 
can you deduce about the objects that 
slammed into the Moon?

 To see all the files available to you, you may need 
to change the selection in the box that says “List 
Files of Type”  from “FITS Files” to “All Files.”

HOU-IP Windows & Mac OS9 “Open” dialog box SalsaJ “Open” dialog box
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In Salsa J, the coordinates are indicated indicated 
in the upper left just below the toolbar.

3. Pixels and Coordinates

Question 2. The word “pixel” is short for “picture element” 
Describe in your own words what you think that means.

Each pixel in an image can be located or identified by numbers that 
are called the pixel’s (x,y) coordinates, This is exactly the same way 
that points on a graph are identified.  The X-coordinate of a pixel is 
how many pixels it is horizontally from the lower left corner of the 
image. The y-coordinate of a pixel is how many pixels it is up from 
the lower left corner on the image. hence the coordinates of the 
lower left corner pixel is (0,0), also called the “origin.”

In HOU IP Windows and Mac OS9, the (x,y) coordinates for the current 
position of the cursor on the image are shown in the Status Bar at the 
bottom right corner of the screen:

 (

In this example, X: 134 
means the cursor is 134 
pixels to the right of the 
origin, and Y: 60 means 
the cursor is 60 pixels 
above the origin.

Status Bar
X:  is  the p ixel  number 

(coordinate) from left to 
right 

Y:  is  the p ixe l  number 
(coordinate) from bottom 
to top

Notice what happens 
to the coordinate 
numbers as you 
move your mouse 
around on the image.

For SalsaJ users
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Answer Box

4. Zooming

Zooming makes the image look bigger. In HOU-IP Windows 
or Mac OS9, there are two ways to zoom:

a. Zoom Factor. Towards the right side of the tool bar, find 
a number by the word “Zoom.” 

 It looks like this:  

Change the number (It’s called the “Zoom Factor.”). Press 
the “Return” key or click the “Redraw” button to make your 
choice of zoom happen. Try a few different values for zoom 
to see what they do.  

For SalsaJ users
In SalsaJ, you can “zoom” the image 
using the magnifying glass tool in the 
tool bar.  Just click anywhere in the 
image and it zooms. Can you figure 
out a pattern to how much it zooms 
on each click?

To “Unzoom” hold 
doen the “Option” 
key while clicking 
on the image.

Answer Box

Answer Box

Question 3. What are the 
coordinates of the 
center of the largest 
crater?

Question 4. How many 
pixels wide is the 
largest crater?.

The edge of the crater is not 
always well-defined.  Use your 
best judgement in deciding where 
the crater starts and stops.

Question 5. How many pixels wide is the entire 
iamge?  How many pixels tall is it?

pixels 
wide

pixels 
tall

If you choose a big enough zoom factor, you will see that 
the image is made of a bunch of little boxes—the “pixels.” A 
pixel is the smallest piece of the picture and has a particular 
brightness value associated with it.
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In HOU-IP Windows and Mac OS9, every time you 
use the Zoom Box Tool, a new window is created. If 
you use the Zoom Box several times, your computer 
screen will become cluttered with windows, but you can 
easily get rid of any them by simply using the “Close 
Window” function. To close all zoom box images: 

For Mac: Click in the box in the top left corner of each 
image window. Click “Don’t Save” each time.

For PC: Click the box with an “x” in the top right corner 

of the image window. 

Question 6. What is the maximum 
zoom factor possible with this 
software? How many “pixels” fit 
in the display window at that 
zoom factor?

Question 7. At what zoom factor 
is each pixel as big as your 
thumbnail?

Answer Box

b. Zoom Box Tool. [Not available in SalsaJ] Set the Zoom factor back to “1.” 
With the Zoom Box tool, you can “click and drag” to zoom in on an area. 

Find the Zoom Box Tool in the “Data Tools” menu:

Your cursor will change to  (Zoom Box cursor) but only when it is actually 
on the image. Click-and-drag the zoom box cursor over the area you would 
like to zoom in on.  The image processor will create a new image window 
showing an enlarged view of the portion of the image you picked.

Factor is a mathematical term having to do with multiplication.  If you choose a 
Zoom factor of 2, then the size of the image is doubled; each pixel is made twice 
as wide and twice as high.  For higher values of zoom factor, two things begin 
to happen: (1) The whole image does not fit on the screen—you need to scroll 
to see parts that are not visible, and (2)  You begin to see each pixel box.

Maximum Zoom #of pixels

Answer Box

Prediction Observed Zoom 

Answer Box

Answer Box

Zoom Box Questions (HOU IP only)
A. Do another zoom box in the new 

zoom box window. What is the 
zoom factor for the new zoom box 
window?

B. Zoom box again inside the second 
zoom box window. What is the 
zoom factor?

C. What do you predict the zoom factor 
will be after you have zoom boxed 
six times?  Check if your prediction 
is correct.

 is a cleanup tool and will get rid of red zoom 
boxes that clutter up an image. The cleanup tool is 
also in the “View” menu: “Clean Up Marks.”
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5. Measure Brightness

You can generally tell where bright and dark areas 
are just by looking at the image. But if you want to 
know exactly how bright or dark a particular spot 
on the image is, use the “Counts” display. In HOU 
IP Windows and Mac OS9, Counts can be found in 
the lower right corner of the screen (next to the X-Y 
coordinates):

The “Counts” number is the exact BRIGHTNESS of the 
pixel that the cursor is on.  “Counts” is a measure of 
the total amount of light that the telescope received 
at that spot on the image.

Question 8. How bright is the brightest pixel in the image? 

 What are its coordinates?

Question 9. How bright is the darkest pixel in the image? 

 What are its coordinates?

Answer Box

Answer Box

X = Y = 

X = Y = 

In SalsaJ, Counts are in 
the upper left corner
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A meteor is a bright streak of light in the sky (a 
“shooting star” or a “falling star”) produced by 
the entry of a small meteoroid into the Earth’s 
atmosphere. If you have a dark clear sky you 
will probably see a few per hour on an average 
night; during one of the annual meteor showers 
you may see as many as 100/hour. Very bright 
meteors are known as fireballs. 

Meteorites are bits of the solar system that have 
fallen to the Earth. Most come from asteroids; a 
few probably come from comets. A small number 
of meteorites have been shown to be of Lunar 
(15 finds) or Martian (13 finds) origin.

 Meteoroids are bits of the solar system that are 
still flying around the solar system.

Explanation: What happens when a meteor 
hits the ground? Usually nothing much, as 
most meteors are small, and indentations they 
make are soon eroded away. 49,000 years ago, 
however, a large meteor created Barringer Meteor 
Crater in Arizona, pictured above. Barringer crater 
is over a kilometer (1.186 kilometers or .737 miles) 
across. In 1920, it was the first feature on Earth 
to be recognized as an impact crater. 

Barringer Meteor Crater homepage: http://www.
meteorcrater.com/

Today, over 100 terrestrial impact craters have 
been identified. Calvin J. Hamilton’s web pages 
“Views of the Solar System” at  http://www.
solarviews.com/ has excellent information on 
terrestrial impact craters.

Barringer Meteor Crater in Arizona

Meteor showers can be very impressive. Samuel Taylor Coleridge’s famous lines 
from The Rime of the Ancient Mariner may have been inspired by the Leonid meteor 
shower that he witnessed in 1797: 

     The upper air burst into life! 

     And a hundred fire-flags sheen, 

     To and fro they were hurried about! 

     And to and fro, and in and out, 

     The wan stars danced between 

     And the coming wind did roar more loud, 

     And the sails did sigh like sedge; 

     And the rain poured down from one black cloud; 

     The Moon was at its edge 

Image from: http://antwrp.gsfc.nasa.gov/apod/ap971117.html 

Credit: D. Roddy (LPI)

[From: http://www.seds.org/nineplanets/nineplanets/meteorites.html]
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    (x,y)Coordinates  Diameter  Diameter Diameter  
    of crater center in pixels in km* in miles*

          X       Y

 1    

 2    

 3    

 4    

 5    

 6    

 Largest  
 Crater   

I-B. The Crater Game

Rules: 

a. Teacher picks a crater and 
calls out the coordinates 
of  the center of  the 
crater.

b. Write the crater center 
coordinates on chart (at 
right) and put the crater 
number at the proper 
location in the Moon 
image (below).

c. Measure  the  c ra te r 
diameter in pixels, write 
it in the chart, and raise 
your hand to indicate you 
have found the answer. 

d. First player to find crater 
diameter picks the next 
crater and calls out the 
coordinates of its center, 
then back to step (c).

e. Compute crater diameters 
in kilometers, using the 
conversion factor: 1.1 
km/pixel  (each pixel 
represents 1.1 km on 
the Moon).  Write the 
diameters in the chart.

 Diameter (D)  =  (N pixels)  
x  (1.1 km/pixel).

g. Use 1 mi = 1.6 km to 
convert to miles.
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moon1.fts:

moon5.fts:

I-C. Moon Measure 
1. Moon Features. Pick any of the 6 Moon 
images shown on this page and do the following, 
recording any data, observations or computations 
for each on the following pages.

a. Open a Moon image. 
b. Identify a crater.
c. Find (X,Y) coordinates of the crater center 

using status bar.
e.g. (x,y) = (134, 60) 

d. Describe the feature with words and make 
a sketch of it. 

e. Measure the diameter of the crater in pixels 
using the Status Bar (x,y coordinate display) 
or the Slice Tool (see instructions for using 
the Slice Tool on the next page).

f. Find the  pixel to kilometer conversion factor 
these images by selecting “Image info” in the 
“Data Tools” menu of the Image Processing 
software. The conversion factor, in  km/pixel, 
is towards the end to the” Image info text.

g. Compute the crater diameter in kilometers.

2. Circumference. Measure the circumference of a 
crater by one of the following methods:

a. Measure the crater diameter (D) and use the 
formula for circumference:  C  =  2πr  =  πD

b.  Use the Slice Tool (instructions on page 16) to add 
together a series of slices along the crater rim. 

  Convert to miles or kilometers.
  1 mile = 1.609 km.  1 km = .6214 mi.

moon6.fts:

moon7.fts:

moon16.fts:

In SalsaJ
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Make additional worksheets as needed

Moon Feature

a. Moon image     b. Coordinates of feature (e.g. crater center)      c. Sketch

   _______.fts       X= ______  Y=  ______

d. Feature type/Description:

e. Diameter/dimension ________ pixels

f. Conversion Factor:  _________ km/pixel

g. Diameter/dimension _________ km

Moon Feature

a. Moon image     b. Coordinates of feature (e.g. crater center)      c. Sketch

   _______.fts       X= ______  Y=  ______

d. Feature type/Description:

e. Diameter/dimension ________ pixels

f. Conversion Factor:  _________ km/pixel

g. Diameter/dimension _________ km

Moon Feature

a. Moon image     b. Coordinates of feature (e.g. crater center)      c. Sketch

   _______.fts       X= ______  Y=  ______

d. Feature type/Description:

e. Diameter/dimension ________ pixels

f. Conversion Factor:  _________ km/pixel

g. Diameter/dimension _________ km

Moon Features Worksheet
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Using the Slice Tool
a. Select the Slice tool (in the “Data Tools” 

menu for HOU-IP Windows and Mac 
OS9).   
Your cursor will change to the drawing 
cursor: 

 (same as for Zoom Box)
b. Using the Slice drawing cursor, draw (click 

and drag) a line from one point on the 
image to another point on the image. 

c. A Slice graph will appear showing distance 
in pixels along the x-axis and brightness 
Counts of the pixels on the y-axis. If you 
drag the cursor anywhere in the graph, 
a corresponding dot will appear on Slice 
line in the image. The distance along the 
line (in pixels) can be read on the x-axis 
of the graph.  This is an easy way to see 
the distance (in pixels) between various 
points along the slice line.

In the example below, the graph shows peak 
brightnesses for the crater rim at about 18 
pixels and 95 pixels along the slice line. 
The crater diameter, in pixels, would be 
the difference: 95 - 18 = 77 pixels.

The dot that appears on the slice line in the image corresponds to 
the spot on the slice graph where you click.

You can increase the number of  “tick marks” on the 
x-axis by selecting “Axes” in the “Options” menu after you 
have drawn a Slice.

After you click and  
drag the slice line,  
the Sice graph pops up...

In SalsaJ, “Slice” is called  
“Plot Profile” and it’s in the “Analyse” 
menu. [Remember to click in the 
yellow toolbar first, before selecting a 
menu item.]

In SalsaJ, you need to draw the line 
first with the line select tool. Click on 
this icon:

and then click and 
d rag  to  c rea te  a 
line on the image. 
Then Choose “Plot 
Profile” in the Analyse 
Menu. The graph will 
appear.
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Answer Box

Answer Box

1. Angle of Sunlight. When you make a model of a crater based on a 
telescope image and try to make its appearance match the that of the telescope 
image, how the crater looks depends on the angle of Sun’s rays on it.  .

Question 10. Make a sketch showing your model crater, the 
model Sun, and the angle that the rays of sunlight must be 
to make the shadows look right for the Moon image.

I-D. Making Model Craters 

2. The Moon Rotates. The Moon’s rotation rate (the time it takes to spin once 
on its axis) equals the period of revolution around the Earth (the time it takes 
to orbit Earth).  Because of this fact, the Moon always keeps the same face 
pointing towards the Earth.  It wasn’t until humans sent spacecraft in orbit 
around the Moon that we ever saw the “back-side” of the Moon.  Note that 
the “back-side” of the Moon is not the “dark side of the Moon” (except during 
full Moon).  There is day and night on the Moon the same as on Earth, except 
the length of a day on the Moon is about a month long. 

Question 11. How many Earth days equal one Moon day?

Question 12. How hot do you think it gets on the Moon during 
the lunar daytime?

Question 13. Where is the most likely place for us to find water 
ice on the Moon?

Answer Box
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I-E. Moon Phases

Answer Box

1. Observing the Moon Phases. The Moon goes 
through a cycle of phases that lasts as long as its orbit 
around the Earth.  For about two weeks, after full Moon, 
it’s easiest to see it in the morning after sunrise.  In the 
subsequent two weeks, after new Moon, it is easiest 
around sunset or after.  

As you watch the Moon for one full cycle of phases, make 

2. Modeling Moon Phases. 

Question 14. Draw lines to match Moon shapes with Moon phase names.

Question 15. What is the difference between the “dark side of the 
Moon” and the “back-side” or “far side” of the Moon?

Waning Crescent  First Quarter  Last Quarter  Full  Waxing crescent

Optional: alternate 
right and left fists 

a drawing in a chart (page 17) showing it’s shape each day along with 
how far across the sky it appears from the Sun, in “fist” measurements.  
To measure in fists, you hold your fist out at full arm’s length, place the 
bottom of your fist at the “starting place” and notice where the top of 
your fist is. Then move your fist one “fist-length” so that the bottom of 
your fist in its new position is where the top of the fist was in the first 
position. Continue moving fist-length by fist-length, counting as you go, 
until you reach the “stopping place.” 
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Question 16. During 
what Moon phase 
could there be 
a solar eclipse 
(Moon blocks the 
Sun)?
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Answer Box

Question 17. During 
what Moon 
phase could there 
be a lunar eclipse 
(Moon goes into 
Earth’s shadow)?

Answer Box
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http://kepler.nasa.gov/ed/SimMoon.html
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3. Comet Structure. A comet 
has a bright core called a nucleus 
surrounded by a diffuse but bright 
coma. The nucleus and coma 
combined are often referred to 
as the head of the comet. The 
tail of the comet is the part that 
spreads out gradually from the 
head.  Label in your drawing 
the parts of the comet: nucleus, 
coma, head, tail.

1. Comet Hale-Bopp. In March 1997, 
the comet Hale-Bopp made a fantastic 
appearance in the night sky. 

2. Sketch and describe the comet. Open 
comet image halebopp.fts or halebopp_apr97.
fts. Make a sketch of the comet and write an 
accompanying description (below).

II. Comets

II-A. How Long is a Comet’s Tail?

Sketch the comet (above) and describe it (below).
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Question 18. Find the brightest pixel in the nucleus of the comet. Record 
the (x,y) coordinates and the brightness Counts of that pixel:

  x = ________,  y = ________   Counts  = _________

4. False Color Comet 

Change Palettes. Select a different palette from the 
palette menu (in HOU-IP Windows and Mac OS9). That 
brings out different details in the comet.

Question 19. Which Color Palette (or LUT) 
seems best for bringing out the most details 
in the comet? Which details?

In SalsaJ, the equivalent of “Color 
Palette” is “Lookup Tables” (LUT) 
which is found in the “Image” menu. 
Remember to click on yellow toolbar 
before using any of the menus.

 Find the pixels with the same (x,y) coordinates 
that you determined in Question 18 for the 
brightest part of the nucleus.

Question 20. Do the brightness 
Counts change when you switch 
color palettes? 

 Yes No   (circle one)

Question 21. What color is the 
brightest pixel in the nucleus? 

Question 22. Is there any 
relationship between the colors 
and the brightness of the comet 
in the colored image? 
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6. Adjust Display Brightness and Contrast: the Min/Max 
Tool. Slide the red and blue sliders on the Min/Max bar to bring 
out more detail in the image. 

Answer Box

5. Color Palette Bar. In the “View” menu (HOU-IP Windows 
and Mac OS9), select the Color Palette Bar. In the window 
that appears, colors are associated with brightness 
counts.

Question 23. Which colors are associated with 
the dimmest pixels?

 Which colors are associated with the 
brightest pixels?

Which colors are in the mid-range of brightness?

In SalsaJ, the equivalent of “Color 
Palette Bar” is “Show LUT” in the 
“Image” menu.  Remember to 
click on the yellow toolbar before 
selecting any menu item.

Question 24. Describe what happens 
when you adjust Min and Max.  
When I move the Min (red) 
slider, this is how the color of 
the pixels in the image change:

In SalsaJ, the equivalent of the Min/Max tool is “Brightness/
Contrast” which can be found in the “Adjust” item of the 
“Image” menu.
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7. About False Color. False color imaging 
is becoming a widely spread means of 
communication; e.g., weather maps. By 
creating your own color image of the comet, 
you control how the Image Processing 
software displays data to make particular 
details easier to see.

The Color Palette Bar (activated from 
the “View” menu), is a chart showing the 
relationship between either (a) shade of grey 
and pixel brightness or (b) color and pixel 
brightness, depending on what palette is 
selected in the Palette Menu.  It helps you 
see the changes in  brightness over the whole 
image and the Counts that are associated 
with those changes.

 When first confronted with opening a new 
images, it is sometimes difficult to see 
anything at all. Often narrowing the Min/Max 
range can help make the display more useful. 
An excellent way to start out is to look around 
for the brightest and dimmest pixels in the 
image and set the Min/Max values to those 
values by typing the Counts of the brightest 
pixel in the Max box and the Counts of the 
dimmest pixel in the Min box. Then narrow 
the Min/Max range from there.

Question 25. Where is the end of the 
comet’s tail? Find the pixel that 
is at the “very end” of the comet’s 
tail and write its coordinates, 
brightness counts, and color. Note 
the “length” of the tail can seem 
to change with different Min/Max 
settings.  Record and compare (in 
the box above) the end of the tail 
for two different Min/Max settings.

 Min/Max Setting End of the comet tail

 Min ___________  Max __________  x = ______,  y = ______   Counts  = _________

 Min ___________  Max __________  x = ______,  y = ______   Counts  = _________

8. Light and Temperature. Comets cannot 
be detected when they are far away. At great 
distances from the Sun, a comet is just a 
body of solid material, frozen ices and rock 
of various sorts. As the comet gets closer to 
the Sun, it begins to warm up and the ices 
vaporize (sublimate) and form the coma and 
tail of the comet. As it gets still closer to the 
Sun it becomes even hotter and radiates 
light and becomes visible. Comets actually 
have two tails: one made of dust that we can 
see only by sunlight reflecting off the dust 
particles, and another made of ions (ion tail) 
that glow—giving off their own light.
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Question 26. Do you think Earth is a 
spinning planet? 

   Yes    No    (circle one)

Question 27. Do you feel the spin of 
Earth?

   Yes    No    (circle one)

II-B. Comet Set
When we observe the sky from Earth, it looks like objects in 
the sky change position. Think about how our Sun appears 
to rise and set!

Sunset... July, 1990, from Lawrence Hall of Science.  

Photo by Vivian Hoette

We are all familiar with spectacular sunsets. 

Like the Sun, Comet Hale-Bopp also disappeared below the 
horizon. 

Question 28. Does the spin of the 
Earth affect how we see the sky 
from Earth?  How? 

Answer Box



II. Comets 23

Question 29. Compare the position of the comet to the tree as the minutes 
pass. Describe its motion.

Question 30. Does the comet seem to be moving with respect to the 
background stars?      Yes No (circle one)

Question 31. What surprises you?  

Question 32. Explain why the comet appears to move as it does.

Images: Yerkes Observatory, Wisconsin. March 10, 

Even ing Comet 
Watch...

Comet Hale-Bopp 
also appears to 
move  as  Ear th 
spins. Notice the 
comet’s changing 
position relative to 
the horizon. 

Answer Box

Answer Box

Answer Box
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II-C. Comet Motion

Does a comet’s position change among the stars in four days?

1. Look at the comet’s position on Monday and then on Friday. In both images, East is to 
towards the left and South is down.

First Observation:

 Monday, Feb. 24, 1997 5 a.m. 

Second Observation: 

Friday, Feb. 28, 1997 5 a.m. 

In order to determine if an object in the sky 
is really moving, or if it’s just the Earth’s 
spin that just makes it look like the object’s 
moving, we need to see if the object changes 
position relative to other things in the sky, like 
the stars. 

Because of how comets are shaped, many 
people think of them as moving very fast 
through the sky, much like a meteor.  Meteors 
appear to traverse large sections of the sky in 
fractions of a second. Do comets move that 
way too?  How long does it take to watch a 
comet cross the sky? Seconds? Minutes? 
Hours? Days? Months?

Many people just don’t know the difference 
between comets and meteors and they use 
the words interchangeably.  By the time you 
finish with this session, you should be able to 
explain the difference between a comet and 
a meteor to your family and friends.

Our perception of how fast something is 
moving depends upon its distance away 
from us. We see the change in the position 
of Hale-Bopp because it is close, part of our 
Solar System. The stars in these images are 
in our Milky Way galaxy, tens to hundreds 
and thousands of light years away. As a 
consequence, even though the stars are 
moving much faster than the comet, changes 
in their position are not seen except over 
millennia. You see the same effect if you 
compare an airplane flying at 30,000 feet with 
one about to land at an airport.

Comets typically have very elongated orbits 
resulting in a long time between appearances. 
Haley’s Comet is an example; it comes back 
every 76 years.
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In this box, sketch combine details from both 
images to show the motion of Comet Hale-
Bopp.

a. Sketch several stars in the image. 
b. Show both Monday and Friday 

positions of the comet. 
c. Draw an arrow to show the motion of 

the comet. 
d. Label the date of each comet 

position. 
e. Use a dotted line to show the comet’s 

path before and after the Monday 

Question 33. Write about Comet Hale-Bopp. What surprises you? 
Explain what you think is happening. What are your questions?

2. Find the same stars in both images.  
Use these stars as reference points.  
Label some of them with letters or 
numbers, for easy reference.

Answer Box

Answer Box

Question 34. Which way is the comet moving, towards 
the North, East, South or West?
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Answer Box
Question 35. Explain the difference between a 

comet and a meteor.

Question 36. How long does it take to watch a comet cross 
the sky? (Circle correct answer)  

Seconds    Minutes    Hours     Days   Months
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To draw an ellipse:

a. With pen, mark the separation of the foci. 
b. Stick a fastener through each focus.
c. Drape a string loop over the fasteners.
d. Pull the string taut with the tip of a pencil and draw the ellipse. 
e. Label the ellipse (comet, Pluto, Earth, or asteroid)

Foci separations: for comet—10 cm; for Pluto—5 cm; for Earth—0.4 cm; for asteroid—7 cm

paper fasteners at foci
pencil

string

Keep the string taut 
as you draw.

I-D. Comet Orbits
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2. Hildrun. Open the files Hildrun1.
fts and Hildrun2.fts.

These images were taken 15 minutes 
apart. Of the three bright objects, two 
are stars and one is an asteroid. How 
can we find the asteroid? Decide 
which one you think is asteroid 
Hildrun.   

It might help if you could compare 
some distances between the three 
bright objects, since the distance between the two that 
are stars would not change. The distances between a 
star and an asteroid  will change. 
Use the Slice tool in the Data Tools menu to  measure 
the distances between the three bright objects. Compare 
measurements in Hildrun1.fts to measurements in Hildrun2.
fts to determine which object is the asteroid.

III. Asteroids 
As you know by now, our Solar System is more than just planets and moons. 
Anything that orbits around the Sun is a part of the Solar System. We have 
already looked at comets, and now we look at asteroids. 

1. Sappho. Open the images sappho_a508.fts and sappho_a533.fts  from 
the image file folder. Click and drag the image windows to move them side 
by side. The image sappho_a533.fts might appear quite peculiar when first 
opened. Adjust the Min/Max settings as needed.

These images are of the same region of the sky but were taken about 15 
minutes apart. One of the objects in the image is an asteroid named Sappho. 
It appears to be moving relative to the background stars because it is closer 
to Earth.

Select a color palette and adjust min/max until you see enough objects 
in the image to compare and match patterns. Can you tell which object is 
Sappho?

 Question 37. What are the (x,y) coordinates of Sappho? 

Answer Box

Can you also find the asteroid Iris in 
the images iris1.fts and iris2.fts?

In sappho_a508: X= ______ Y=  ______

In sappho_a533: X= ______ Y=  ______

iris1: X= ______ Y=  ______

iris2: X= ______ Y=  ______
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3. Subtracting Images to Find Asteroids

Another nifty tool to use in finding things that 
have moved in two images (such as asteroids) 
is the Subtract tool in the Manipulation menu 
(HOU-IP Windows and Mac OS9).

a. Open Hildrun1.fts and Hildrun2.fts.
b. Click on Hildrun1.fts. In the Manipulation 

menu, select Subtract.
c. Click on Displayed Image. Choose Hildrun2.

fts. Click on the down arrow for this. 
d. Click on Display result in a new window. 

Click OK.
e. View your results. The image processor 

has subtracted the brightness Counts of 
every pixel in the first image from each 
corresponding pixel in the second image. 
Do you see an object with a double 
position?  It will be a black object at its initial 
position in Hildrun1.fts and a white object at 
its position in Hildrun2.fts. Is this the object 
you thought was the asteroid?

In hildrun1: X= ______ Y=  ______  In hildrun2: X= ______ Y=  ______

The log tool changes the display to enhance the 
brightness of dim objects and can help you to 
see those objects in certain images. Try it out 
on some images and see what it does...

Using the slice tool (or “Plot Profile”) to measure the 
separation of two stars (or star and asteroid)

Question 38. 
Which object 
is asteroid 
Hildrun? 

In SalsaJ, the “Subtract” function is in the 
“Operations” menu, under “Image Calculator.” 

In SalsaJ, you can find Log in the menu:

Operations > Single Image Operators > Log

Remember to click on the yellow toolbar before 
selecting any menu itme.
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Asteroid Lore
A camera on the Near Earth Asteroid Rendezvous 
(NEAR Shoemaker) spacecraft  orbiting asteroid Eros 
was used to construct this image of Eros on February 
29, 2000 from an orbital altitude of about 200 kilometers 
(124 miles). The diameter of the crater near the top is 
5.3-km (3.3-mi).

1. What are asteroids made of? All the bodies in the 
Solar System are made of elements in the periodic table, 
but which elements varies from object to object. Some 
asteroids have probably been around since the Solar 
System first formed, so analyzing the matter in asteroids 
helps to understand the formation of the Solar system. 
Asteroids are made of rock and metals like iron and 
nickel.  

4. Find asteroid Ryokan

Open Ryokan1.fts and Ryokan2.fts. These images were also 
taken 15 minutes apart. Most of the bright objects are stars. 
One is asteroid Ryokan! 

Question 39. Which object is asteroid Ryokan?
Please write its coordinates:  

Explain your reasons and methods of analysis.

In ryokan1:  X= ______ Y=  ______

In ryokan2:  X= ______ Y=  ______

2. How do we see asteroids? They do not give off their own light, but reflect 
sunlight as they orbit the Sun, like planets and moons.   

3. How big are asteroids? Asteroids are much smaller than most moons 
and planets.  They range in size from a few hundred meters to a few hundred 
kilometers. Bodies that are a lot less than a hundred meters or so, would 
probably be categorized as meteoroids and not asteroids.
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4. Where are asteroids found and how fast do they move? 
Asteroids change position in our starry sky as they orbit the Sun. 
Since they are part of our own Solar System, they are closer to us 
than the background stars. Most asteroids are found in the inner Solar 
System, inside the orbit of Jupiter. Even though they are moving very 
fast in their orbits, thousands of kilometers per hour, they appear 
to move slowly through the sky, since they are many millions of 
kilometers away from us. The asteroids that are closer to the Sun 
move faster than those that are farther out near  the orbit of Jupiter. 
Our Earth also orbits the Sun and rotates on its axis, so it is the 
combined motions of the asteroids and Earth that cause the shift in 
positions of the asteroids in our images. The speed of an asteroid in 
its orbit does not vary as much as speed of a comet, since asteroid 
orbits are usually not as elongated as comet orbits.

The images of Hildrun and Ryokan were taken for HOU with the 3.5 
meter telescope at Apache Point Observatory in New Mexico from 
the Adler Planetarium & Astronomy Museum by University of Chicago 
Astronomer, Dave Cole. 

5. Can an asteroid or comet crash into Earth? Yes, 
but not very often--once every several million years or so 
on the average. 

6. What happens when an asteroid crashes into 
Earth? That depends on the size of the asteroid 
(or comet, in the case of comet impact). A number 
of craters have been discovered on the Earth, 
such as the Barringer Meteor Crater in Arizona 
(photo on p. 10). That one is somewhat over a 
kilometer in diameter and was caused by an 
approximately 50 meter-sized object striking 
the ground at that site, one twentieth the size 
of the crater. 

Most craters on Earth have been worn away 
by erosive processes due to wind and water. 
Craters on the Moon are still obvious because 
of the lack of an atmosphere and the resultant 
erosion.

 There is a crater in the Gulf of Mexico 
near the Yucatan Peninsula which was found 
to be about 65 million years old, created just 
about when the dinosaurs and other species 
became extinct. The object was probably 
about 15-30 km (10-20 miles) across, created 
a hole about 30 km (20 miles) deep, and it 
was converted instantly into white hot vapor 
along with parts of the ground where it hit. It 
must have created debris that crashed down 

in neighboring areas, and it threw dust into 
the Earth’s atmosphere circling the globe, 
dimming the sunlight. Hot debris raining down 
over vast areas probably caused even green 
vegetation to dry out and burst into flames 
spontaneously, causing global forest fires.

 It would behoove us to seek advance 
warning of such an approaching body whose 
orbit may intersect the orbit of Earth. Such 
an object is called a near Earth asteroid or 
comet. An asteroid could come in quickly, but 
it may be technically possible to deflect an 
asteroid from an Earth impact course, if there 
is enough advance warning. The techniques 
you have learned in this session are the 
techniques astronomers use to search for 
such bodies.
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Solar System was chosen as a name because it is the Sun’s 
gravity that keeps the planets and other objects in orbit 
around the Sun. In the case of Jupiter and its moons, this is 
often called the Jovian System, a sub-system within the Solar 
System. Jovian means of or about Jupiter.

1. Finding Jupiter’s bands and moons.

Open imagejup1_991101g.fts in the “jupiter_and_its_
moons” file folder.

In this image of Jupiter, the largest planet in our Solar System, 
you should be able to find

a. Bands on Jupiter—giant weather/climate zones.

b. The Galiliean moons of Jupiter.

You will need to adjust the Min/Max differently for each feature, 
to get the best view. 

IV. Planets

IV-A. Jupiter and Its Moons

Answer Box

Min__________  Max__________

Min__________  Max__________

Question 40. What Min/Max (or 
Brightness/Contrast) settings are 
best to see bands on Jupiter?

Question 41. What Min/Max (or 
Brightness/Contrast) settings are 
best to see moons of Jupiter?

Question 42. Make a sketch of the image showing bands 
and the moons of Jupiter.
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Ganymede is near the furthest Eastern (left in the image) 
side of its orbit as we see it.  

Question 45. What is the radius of Ganymede’s 
orbit in Jupiter diameters?

Hint: Use the slice tool to help you measure Jupiter 
diameter and distance to Ganymede. 

Question 43. Record the (x,y) coordinates of each moon. 
Please write all answers and coordinates:

 (x,y) coordinates of 1st moon  _________ , _________

 (x,y) coordinates of 2nd moon  _________ , _________

 (x,y) coordinates of 3rd moon  _________ , _________

 (x,y) coordinates of 4th moon  _________ , _________

Question 44. Where are the other two?  

2. The radius of Ganymede’s orbit.

Open the files jup2_july24_97.fts and  jup2_july25_
97.fts.  In jup2_july24_97.fts, the image taken July 24, 
1997, all four moons are visible.  From left to right they 
are Ganymede, Io, Europa, and Callisto.  Io is near the 
furthest edge of its orbit from our vantage point.

In jup2_july24_97.fts, the image taken July 25, 1997, 
only two of Jupiter’s moons are visible. 
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Images captured at Yerkes Observatory, with 41 in reflector. 

* UT stands for Universal Time. This is what all astronomers, 
worldwide, use and it is the time in Greenwich, England.

Answer Box

3. The radius of Io’s orbit.

Open Jupiter 107.fts and Jupiter221.
fts.

September 26, 1996.  The first image 
was taken at 1:07 UT* by Walter Wild 
with the Yerkes Observatory 41 inch 
reflector telescope.  The second image 
was taken at 2:21 UT time. Jupiter’s 
moon, Io,  was approaching its furthest 
position East of Jupiter from our point 
of view. . 

Question 46. What is the 
radius of Io’s orbit in 
Jupiter diameters?  

Describe your method.  
[Hint: the center of the orbit of the moon 
is very near the center of Jupiter.]
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IV-B. Jupiter Rotation
Does Jupiter rotate faster or slower than Earth?  How many hours 
are in a jovian (Jupiter) day? To answer these questions, 

Look for the Great Red Spot!
Open the image of jup_rotates341jb.fts.  Look for the Great Red 
Spot.  In this image it appears as a light gray oval shape.  This is 
a huge storm on Jupiter that people have seen through telescopes 
for more than 300 years!  

Question 47. How big does this storm seem compared 
to Jupiter itself?

(Jupiter is about 140,000 km. diameter)

Open other Jupiter images from October 11th, 1998  

3:41 Universal Time jup_rotates341jb.fts

4:08 Universal Time  jup_rotates408jb.fts 

4:11 Universal Time jup_rotates411jb.fts

Answer Box

Question 51. Will you always see the 
red spot?  Why or why not?

Answer Box

Question 48. Do you see evidence of rotation?
If so, which way?

These images were taken for Jackie 
Barge from Reilly School in Chicago 
by University of Chicago’s Yerkes 
Observatory with the 24 inch reflector 
telescope

Question 49. How do you think 
Jupiter looked an hour before the 
first  image (3:41)? 

 
Question 50. How about two hours 

after the last image (4:11)? 

Answer Box

Answer Box

Question 52. Make an estimate of 
how long it takes Jupiter to 
rotate once? 

(This is called Jupiter’s rotation period)
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IV-C. Planet Survey
1. Use your web browser to find the web page named: 

“What Is It? How Far Is It?” It’s at  
http://www.lhs.berkeley.edu/hou/activities/whatisit/)

b. In the chart of “Distances of 
Planets from the Sun,” click on 
each “Select Correct Planet” 
in the 2nd column (Names) to 
make the list show all the planet 
names in proper order according 
to their distance from the Sun. 
When you “click-and-hold” on 
any of the boxes, a menu pops 
down with all the planets for you 
to choose from. 

c. In most cases, you can click on 
the little picture of the planet 
in the View column to find out 
if your guesses were correct, 
as well as to find additional 
interesting information about 
the planets.

a. Click on “Nearby Objects.”  All the nearby objects for our purposes in this 
game are in the Solar System.
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1 LIGHT MINUTE (LM) = 
(0.3 million km/sec)(60 sec/min)  =  __________________  million km

1 LIGHT HOUR (LH) = 
(0.3 million km/sec)(3600 sec/hour) =  ___________________ million km

Question 53. Write down the order of the planets in the chart 
below. Fill in the following:

• Planet Name 
• Distance from Sun 
 (in kilometers) 
• Size (in kilometers)

In some cases, the size of the planet is not available in the Planet Survey 
Table. Leave the “size” column blank in those cases. You will find those 
diameters in the next section.

 Object   Object  Distance  Distance in Size 
 number    Name from Sun light-minutes (LM) kilometers 

 or letter  millions of km or light-hours (LH)

 

Planet Survey 
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IV-D. Outer Planets

3. Using the Image Processor to measure planet sizes. 

a. To finish filling in the chart on the previous page for the remaining 
planets, use the Image Processor to open an image of the planet 
whose size you want to measure. They’re in the Solar System folder. 
Use these image names:

Planet File Name Pixel Scale

Mars mars3leutsch.fth 1 pixel = 270 km

Jupiter jupiter.fts 1 pixel = 2200 km

Saturn saturn20010106.fts 1 pixel = 3400 km

Uranus uranus-leutschner940429.fts 1 pixel = 2500 km

Venus venus20010224.fts 1 pixel = 190 km

1. Neptune & Triton.

The brightest object in this image is Neptune. 
The star-like object next to Neptune is its largest 
moon, Triton.

This image was taken by Dave Cole of the University of 
Chicago using the Apache Point Observatory telescope in 
New Mexico by remote control through the Internet from 

Adler Planetarium on Nov. 22, 1997, 01:28 UT.

With HOU IP, open up the neptune_apo.
fts image. Optional: Click on the “Log” 
checkbox (next to the Zoom value box in 
the Tool Bar) 

Question 54. Write down the (x,y) 
coordinates for Neptune and 
for its moon, Triton.

Neptune:  X= ______ Y=  ______

Triton:     X= ______ Y=  ______

b.  Find the diameter of the planet in pixels. 
c. Find planet diameter in kilometers, by 

multiplying the diameter in pixels by the Pixel 
Scale factor (number of kilometers/pixel).
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2. Uranus & Its Moons: Titania, Umbriel, and 
Ariel. With HOU IP, open up the uranus_apo.fts 
image. Click on the Log check box. 

The brightest object in this image is the planet, 
Uranus. The three star-like objects very near Uranus 
are three of its moons. From left to right, they are 
Titania, Umbriel and Ariel. This image was taken 
by Dave Cole of the University of Chicago using 
the Apache Point Observatory telescope in New 
Mexico. Dave operated the telescope by remote 
control using the Internet from Adler Planetarium in 
Chicago on the evening of December 19th, 1997 
(Dec. 20, 1997, 01:28 UT)

For more info on Neptune and Triton, see these websites:

Photo Gallery of Neptune & Triton:  
http://nssdc.gsfc.nasa.gov/photo_gallery/photogallery-neptune.html

Fact Sheet for Neptune: 
http://nssdc.gsfc.nasa.gov/planetary/factsheet/neptunefact.html

Fact Sheet for Triton: 
http://nssdc.gsfc.nasa.gov/planetary/factsheet/neptuniansatfact.html

Question 55. Write down 
the (x,y) coordinates for 
Uranus and each of the 
moons.

3. Find out the distance between 
Uranus and Titania. How far does 
Titania orbit from Uranus? 

Uranus’ axis is tilted 97 degrees 
with respect to its orbit around the Sun. It is tilted so far over that it 
seems to be rolling on its side. At the time of this image, the North Pole 
of Uranus was pointing almost right at the Sun, and therefore towards us, 
since we are very close to the Sun from the viewpoint of Uranus. Since 
Titania revolves in the plane of the equator Uranus, from our point of 
view Titania never went behind or in front of Uranus, but circled around 
the planet, always staying the same distance away. 

A. Measure the distance between Uranus and Titania in pixels.  

Question 56. What is the distance between Uranus and 
Titania in pixels? 
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B. What is the distance between Titania and Uranus in 
kilometers (or miles)? To convert the distance between 
Titania and Uranus in pixels to distance in kilometers, we 
need to know the scale factor: how many kilometers are in 
each pixel. This actually depends on the distance to Uranus. 
The farther Uranus is from us, the more distance each pixel 
represents. At the time this image was captured, the distance 
between the Earth and Uranus was 20.6 AUs. (One AU = 150 
million kilometers.) 

Question 57. How many miles in 20.6 AUs?

At that distance, each pixel on the image represents about 
9,000 km of actual space near Uranus.

Question 58. What is  the distance between Uranus 
and Titania?
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Umbriel _________________ 

   

 Ariel_________________

A. Umbriel and Ariel. Find the distances between 
Uranus and Umbriel or Ariel. Apply the same 
procedure for Uranus’ other two moons.

Question 59. Find the 
distances to:

June 24:   X = _______ Y = _______

June 25:    X = _______  Y = _______

June 26:  X = _______ Y = _______

June 27:  X = _______ Y = _______

Question 60. How far (in km) did 
Uranus move in 1 hr 22 min?

C. Find Pluto.  In the “Worlds Galore” 
folder, you’ll find four images of Pluto:

pluto20010624.fts pluto20010625.fts

pluto20010626.fts pluto20010627.fts

Find Pluto in each image and write down 
the coordinates you find.

Question 61. Where is Pluto in each of 
the four images from June 2001?

Extra challenges: 

km

B. Movement of the Uranian system.

Use images uranus20000918-0425.fts and

uranus20000918-547.fts in the “More Uranus” folder 
to determine how far Uranus moves in an hour and 
twenty two minutes. Assume that Uranus was 19 
Astronomical Units (AU) away when the images were 
taken on Sept.18, 2000. Also, for this telescope and 
camera, at a distance of 1 (AU), each pixel spans 
440 km.
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